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[bookmark: _Toc174600746]Understanding FISAP Selection in PeopleSoft
[bookmark: _Toc174600747]FISAP Report
Using the FISAP process, you report expenses for Federal Campus-Based programs—the Federal Supplemental Education Opportunity Grant (FSEOG), Federal Work-Study, and Federal Perkins Loan programs. The Department of Education uses the distribution of expenditures to evaluate whether institutions are appropriating their federal allocation of Campus-Based funds to applicants with the most need. The reported spending levels affect subsequent year allocations. The programs enable you to transfer certain percentages of funds back to last year or forward to the next year to best use unexpended funds.

For your school to transmit, receive, and report FISAP data, you must submit your FISAP expenditures to the Department of Education through the COD website: https://cod.ed.gov. At that site, you are also able to submit FISAP corrections and view communications from the Dept of Ed. 

To submit your FISAP through COD, you must have access to the COD System with one of the following user role types:

• School User 4-View/Update 
• School Administrator-View/Update 
• School User 6-View/Update 

If you do not have access to the COD System, or you need to have a user role type added to your account, see instructions in  Fiscal Operations Report for 2023-24 and Application to Participate for 2025-26 (ed.gov)

Use the provided structured query report (SQR) to print and to enter the calculated values into the FISAP Dashboard on the COD website. For audit purposes, the Dept of Ed requires that you keep data logs and backups of your final FISAP reports and any records necessary to support their data (for example, the source data for the income grid) for three years from the end of the award year for which you submitted the FISAP. 

For steps on how to get to the FISAP Dashboard in COD, see FISAP Desk Reference 2023-2024 (ed.gov)

The following FISAP report information is generated:
· Part II, Section E. Assessment and Expenditures: 23. Total Federal Pell Grant Expenditures
· Part II, Section F. Information on Eligible Aid Applicants for Award Year
· Part IV, Section C. Funds to FSEOG Recipients: 
· 12. Total Funds to FSEOG Recipients
· 13. Non-Federal Share of Funds to FSEOG Recipients
· Part IV, Section D. Federal Funds Spent for FSEOG Program: 14. Federal Share of Funds to FSEOG Recipients
· Part VI, Section A. Distribution of Program Recipients and Expenditures by Type of Student.

The next four sections discuss:
· Students selected for the report.
· Assessments and expenditures.
· Information on eligible aid applicants.
· Distribution of program recipients and expenditures by type of student.
[bookmark: _Toc174600748]Students Selected
The FISAP report includes only students who:

· Have an FA Term (financial aid term) build source of T-Term or M-Manual. You can view the source on the FA Term Build Statistics page.
· Have an official Institutional Student Information Record (ISIR) on file. You can view the status of a student's ISIR using the EFC Status (expected family contribution status) field on the Federal EFC Summary page.
· Are eligible citizens based on the Social Security Administration (SSA) Citizenship Indicator database match, DHS/INS database match, and secondary DHS/INS database match. You can view the student's citizenship status in the SSA Citizenship Indicator field on the Database Matches page. Additional logic allows either the DHS/INS Match Override or SSA Citizenship Indicator Override on the Database Matches page to determine eligible citizenship status. To do this, select either the SSA Citizenship Override check box or the DHS/INS Match Override check box or both on the Eligible Aid Applicants for Award Year 20xx-20xx page.
· Have awards with financial aid item types of FSEOG, Federal Perkins Loan, Federal Work-Study, or Federal Pell Grant at the time of disbursement. Even if the institution changes the financial aid item type of the award after disbursing the award, the FISAP report still counts the student and the award amount in the proper category.

The FISAP report uses the following rules when categorizing the selected students:

· The most recent effective-dated sequenced ISIR row for students who meet the above report selection criteria.
· The student's National Student Loan Data System (NSLDS) loan year value determines whether the report counts the student as an undergraduate or graduate for the FISAP report.
· If a student is less than full-time based on enrollment status in the final term of the award year, the system counts the student as less than full-time for the entire year for FISAP purposes.
· Total FISAP income is derived directly from the student's ISIR.
· The Central Processing System (CPS) assigns students who meet certain tax filing and income criteria for an automatic EFC of zero. These students have an automatic zero EFC flag set to yes on their ISIR. If set to yes, this flag is on the EFC/DB Matches page in the ISIR Corrections component.
· To qualify as an Auto Zero EFC candidate on the report, the CPS must process the student's ISIR as official and must flag it with a Y in the Auto Zero EFC field. If you make changes to the student's ISIR record, and INAS determines that the student qualifies as an Auto Zero EFC candidate, schools must have the ISIR reprocessed by the CPS. The FISAP report identifies Auto Zero EFC candidates as all students with a Y value for AUTO_ZERO_EFC on the ISIR_COMPUTED table and an O value in EFC_STATUS on the ISIR_CONTROL table.
· The third page of the FISAP report identifies graduate students who received an FSEOG as an undergraduate student in a previous term in the same award year. This page is for your information, because these students are included and reported in the appropriate sections of Application Part VI of the Program Summary Grid, based on the Department of Education's instructions. These instructions stipulate that the funds received by these FSEOG recipients should be categorized in the appropriate undergraduate category (dependent or independent by income). If the student received only FSEOG, the student is also included in the undergraduate category for the unduplicated count. If the recipient also received Federal Perkins or Federal Work-Study funds, only the student's undergraduate FSEOG funds must be reported in the appropriate undergraduate category.
The student is then reported in the unduplicated recipients column only once by using the student's career in the final term of the award year (in this case, as a graduate student). For Federal Perkins and Federal Work-Study students, a student's career for the final term of the award year determines a student's career for FISAP purposes. To verify manually that these students are categorized correctly, use the information on the third page of the SQR report. The system does not generate a third page if no graduate students with an FSEOG exist. 
Note: These bullet point are straight from PeopleBooks, and this last bullet point does not apply to ctcLink colleges (there are no graduate program) but is in this guide simply for information.

[bookmark: _Toc174600749]Assessments and Expenditures
Part II, Section E of the FISAP report lists total expenditures in dollar amounts. The report process gathers award disbursement information based on financial aid item type setup to calculate the total Pell Grant expenditures for the aid year. Financial aid item type is defined with a Source value of ‘Federal’ and a Federal ID value of ‘Federal PELL Grant’ on the Financial Aid Item Types page. These totals include all students who received a Pell regardless of NSLDS loan year.

As of the 2023-2024 FISAP, Dept of Ed stopped collecting Part II, E, 24. Total Expended for State Grants and Scholarship Made to Undergraduates for the Award Year. Therefore, the associated field will show a value of ‘n/a’ on the FISAP report that is generated.


[bookmark: _Toc174600750]Information on Eligible Aid Applicants
Part II, Section F of the report lists the number of eligible aid applicants in an institution by income level. At various taxable and untaxed income levels, it tracks the following information:

	FISAP Report Column
	Eligible Aid Applicants

	A
	Dependent undergraduates without degrees.

	B
	Dependent undergraduates with degrees.

	C
	Independent undergraduates without degrees.

	D
	Independent undergraduates with degrees.

	E
	Graduate and professional students.



[bookmark: _Toc174600751]Distribution of Program Recipients and Expenditures by Type of Student
Part VI, Section A lists the number of students receiving Federal Perkins, FSEOG, and Federal Work-Study awards at various undergraduate dependent, undergraduate independent, and graduate and professional income levels. You can view both the number of recipients and amount of funds for each aid type. This section also lists totals for each aid type and for "automatic" zero EFC students, and provides a summary of funds and recipients at each income level.

The counts in this section of the FISAP report are unduplicated counts because the system counts each student once, whether or not a student receives multiple types of awards.

	FISAP Report Column
	Distribution of Program Recipients

	A
	Federal Perkins Loan Recipients

	B
	Federal Perkins Loan Funds

	C
	FSEOG Recipients

	D
	FSEOG Funds

	E
	FWS Recipients

	F
	FWS Funds

	G
	Unduplicated Count of Students[footnoteRef:1] [1:  PeopleBooks, Oracle; Docs, PeopleSoft CS 9.2, Understanding the FISAP Report ] 





[bookmark: _Toc174600752]FISAP Processing Flow
[bookmark: _Toc174600753]External Award Process for Work Study
	Process
	Process Name
	Process Description
	Review Log Required?

	Query Extract
	
	Pulling Work Study List
	

	File Upload/Download
	
	Upload extract file
	

	Process External Award File
	SFA_EA_STAGE
	Staging extract file
	

	Review Staging Tables
	
	Reviewing staged extract file 
	

	Load External Award File
	FAPPKEAL
	Loading extract file
	

	Manage Awards by Status
	
	Reviewing error list
	

	Mange Student External Awards
	
	Correcting students with errors
	


[bookmark: _Toc174600754]Running FISAP
	Process
	Process Name
	Process Description
	Review Log Required?

	FISAP Report 20xx-20xx
	FAPFSPxx
	Generating FISAP Report
	Y – View/Log Trace

	File Upload/Download
	
	Downloading .CSV files for review
	

	Unduplicated Head Count query
	PSQUERY
	Outcomes used for reporting
	

	Tuition query 
	PSQUERY
	Outcomes used for reporting
	




[bookmark: _Toc174600755]Processing for FISAP
Disclaimer:
In order for the FISAP processes below to work accurately, work study awards need to be reconciled. The External Award Process outlined below is used to post students’ actual work study earnings as “Disbursed” on the student award page. 
[bookmark: _Extracting_Work_Study][bookmark: _Toc174600756]Extracting Work Study Awards
The query mentioned in this process will extract the accepted term amounts from the award page for work study FA Item Types that have “Federal Work Study Program” in the Federal ID field on the FA Item Type 1 tab in the Financial Aid Item Types page.

[image: A screenshot of a computer
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	Navigation
	Description

	Reporting Tools > Query > Query Viewer
	Work study extract query 



· Enter the query name:  CTC_FA_FISAP_WORKSTUDY_EXTRACT
· Select Search
· From the Search Results select HTML

[image: A screenshot of a computer
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Enter the following:
· Institution
· Aid Year

[image: A screenshot of a computer
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Download the results to Excel Spreadsheet.

Note: Even though you will be converting the spreadsheet into CSV later on in the process, do not take a shortcut and select CSV when downloading from PS. If you do, the Item Type field will change the item-type from 931000000000 to scientific notation (i.e. 9.31E+11). Your file will error at the Load External Awards step if you load a CSV full of 9.31E+11 into PS. 
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The downloaded file will appear above your task bar (for Chrome and FireFox).  It may look different for different browsers.  

[image: A screen shot of a computer
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When the spreadsheet opens, select Enable Editing and delete the top 2 rows (Title Rows)

[image: A screenshot of a computer
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Make sure your Item Type field does not have scientific notation like 9.31E+11. If it does, you may have not selected Excel Spreadsheet and selected CSV when you downloaded from PS. To get a valid spreadsheet, either re-download from PS in the correct format or select Column G in Excel and change the format to Number and remove the two decimal places.
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Save the file to your computer as CSV (i.e. comma delimited) file type and rename the file so it can be identified for the upload.

[image: A screenshot of a computer
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Note: Do not open the csv file once it has been saved to your desktop. Opening the csv may cause the file to error during processing.  

[bookmark: _Toc174600757]File Upload/Download
The file created will need to be uploaded for processing to the PeopleSoft server to be used in the following steps

	Navigation
	Description

	PeopleTools > CTC Custom > Extensions > Upload/Download Files
	Uploading recently created work study extract file. 



Enter the following:
· Academic Institution
· Business Process Name - Ext
· Select Search
· Select External Awards 2024

[image: A screenshot of a search box
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Select Upload File and browse for the desired file

When the desired file is located select Upload

Select OK after the file is successfully uploaded
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Tip: Open a new window in PS so that in the next step, you can copy and paste the File Path and File Name from this page. The most common issue users run into with the next process is having a typo or space in the File Path field.

[bookmark: _Toc174600758]Processing External Award Load files
	Navigation
	Description

	Financial Aid > Awards > External Awards > Process External Award File
	Loads extracted file into External Award staging tables for processing



Enter a New or Existing Run Control ID*

Select Search

Note: So that Run Control IDs in the system are all unique, make sure to put your college code and initials in the Run Control ID i.e. WA060_FISAP_WS_LOAD_DE

Enter the following information:
· Institution
· Aid Year
· Load Action = Offer/Accept (The file built will ensure that the disbursed amounts are updated)
· File Mapping ID = CTC_FA_EXTERNAL_AWARDS_DISB_ID
· File Path= /CSTRANSFER/WAxxx/ExternalAwards20yy/zzz
· Where xxx represents the college code (ex: WA300), yy represents the aid year associated with the folder in the file path where you uploaded the file to and zzz represents the File Name csv file name uploaded in previous step
· If you have the previous window open where you uploaded the CSV, copy and paste the File Path and File Name into this field and make sure there are no spaces in between the two

Bad Example with no file name:
/CSTRANSFER/WA160/ExternalAwards2024/
Bad Example with a space:
/CSTRANSFER/WA160/ExternalAwards2024/ 2024_FISAP_WS_EXTRACT.csv
Bad Example with a typo:
/CSTRANSFER/WA160/EXTERNALAWARDS2024/2024_FISAP_WS_EXTRACT.csv
Good Example: 
/CSTRANSFER/WA160/ExternalAwards2024/2024_FISAP_WS_EXTRACT.csv
Select Run
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From the Process Scheduler Request page select OK

[image: A screenshot of a computer
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Ensure the SFA_EA_STAGE process runs to “Success” and “Posted”
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[bookmark: _Toc174600759]Review Staging Tables
	Navigation
	Description

	Financial Aid > Awards > External Awards > View Data File Staging Results
	Reviewing staged data for processing to include student count review, processing status, and student data



Enter the following:
· Academic Institution (Do not leave blank or you may mistakenly select another college’s transaction)
· Aid Year

Select Search

Note: The page should open up without selecting a transaction number since in most cases this is the only time colleges uses External Awards for the aid year.  

If you have used External Awards at a previous time for the aid year, you will need to select the appropriate Transaction Number.

The Transaction Number will be the most current transaction date

[image: A screenshot of a search results
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When the page opens, review the Institution and Aid Year
It is important that you verify that the Institution and Aid Year associated with the Transaction Number is correct.  It‘s possible that multiple colleges could be running the process simultaneously.  If you select the incorrect Transaction Number, you may inadvertently process records for another institution.    

Review the page before proceeding to the next step.

Transaction number – Note this number! It will be used for subsequent processing
Student Count – This count should match the number of students listed on the loaded Excel Spreadsheet

The list of students below the file data will show that they are “Unprocessed” in the Status tab.
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[bookmark: _Toc174600760]Load External Award files
	Navigation
	Description

	Financial Aid > Awards > External Awards > Load External Awards
	Moving staged data to award tables



Enter a New or Existing Run Control

Note: So that Run Control IDs in the system are all unique, make sure to put your college code and initials in the Run Control ID i.e. WA060_PROCESS_FISAP_WS_DE

From the Load External Awards page enter the following information:
· Institution
· Aid Year	
· Status = Unprocessed
· Data Source = External File
· File Mapping ID = CTC_FA_EXTERNAL_AWARDS_DISB_ID
· Transaction Date = The date the file was processed
· Transaction Number (Pulled from earlier processing)
· Update Aid Processing Status
Exclude = CTCEXCLDEA
· Load Processing Rules will default Error

Select Run 
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From the Process Scheduler Request page select OK
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Ensure the FAPPKEAL process runs to “Success” and “Posted”

Note the instance number! It will be used in the search criteria of the next step 
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[bookmark: _Toc174600761]Reviewing Loaded File
	Navigation
	Description

	Financial Aid > Awards > External Awards > External Award Load Summary
	Reviewing the summary of the loaded file. Taking note of the number of students who have been processed, skipped or have loaded to error. 



This page may automatically open without entering any parameters if there is only one instance for your institution for the aid year.

Enter the following:
· Academic Institution 
· Aid Year
· Process Instance number from the previous step 

Select Search

[image: A screenshot of a search box
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Review the External Award Load Summary to see the processing status of the students in the file
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If there are no students Skipped or In Error, you will not have any error files to review in the next step; instead, you may continue your processing by navigating to section: Running the FISAP Report.  

If Errors occur or a student is Skipped, the number of students in the situation will appear next to Skipped or In Error on the External Award Load Summary page. Details on how to load those students are in the processing instructions below. 

[bookmark: _heading=h.2jxsxqh]
Review Error Files
	Navigation
	Description

	Financial Aid > Awards > External Awards > Manage Awards by Status
	Reviewing list of students who have loaded with an Error status.  Used in subsequent processing. 



This section details how to find students who have encountered errors. If you do not have any errors, skip this section and move on to the Running the FISAP Report section. 

Enter the following information:
· Academic Institution
· Aid Year
· Processing Status = Error
· Transaction Number

Select Search

[image: A screenshot of a search box
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The list of students with Errors is produced. Select the Download to Excel button to download the list of students that will need to be fixed in the next section of processing. 
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[bookmark: _Toc174600762]Resolving Errors
	Navigation
	Description

	Financial Aid > Awards > External Awards > Manage Student External Awards
	Steps for processing errors encountered during the load process. 



This section details how to correct students who have encountered errors. If you do not have any errors, skip this section and move on to the Running the FISAP Report section. 

Enter the following information:
· Student ID
· Academic Institution
· Aid Year 

Select Search
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When the page opens, select the Status tab. 
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Select the Error Code hyperlink

[image: A screenshot of a computer
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Error 644: The disbursement allocation is invalid. The Disbursement IDs specified do not match the student's enrollment terms.
Solution:  Select the Award Summary tab and look for the Disbursement Plan that was assigned to the FWS item-type that is erroring. After noting the Disbursement Plan and the terms with disbursements, return to the External Awards tab and select Award tab then the Detail link and enter the missing values.
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Flip the Status to Unprocessed and select Load
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Description automatically generated]

[image: A screenshot of a computer

Description automatically generated]

Other possible errors you may encounter. 

Error 622: Charge Priority not found for Item Type.

Troubleshooting step: All FWS item-types have a CPL on them so the reason for this error is most likely that you loaded a CSV full of scientific notation (9.31E+11 instead of 931000000000) for the Item Type field. Confirm by selecting the Award tab and look at the Item Type field. 

[image: ]

Solution:  Open up the CSV you loaded into the system and confirm all students on the CSV have a scientific notation. You will need to reload a valid CSV without the scientific notation and run through the process again. Extracting Work Study Awards. These error rows will remain in PS so make sure to choose the new transaction number when going through each process.



Error 642: When specifying the disbursement allocation, all entries must have the appropriate term specified if at least one allocation has a term defined. Otherwise, specify the Disbursement IDs or leave both the Disbursement ID and Term fields for all allocations blank.
Troubleshoot step: Select the Award tab then the Detail link. Is there a row of zeroes with a term value missing?
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Solution:  Find the row with the zeroes and enter the term, select OK, flip the Status to Unprocessed then select Load. 

[image: ]
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Review the Assign Awards to a Student page to view the update to the disbursement field for each term(s).



[bookmark: _Toc174600763]Running the FISAP Report
	Navigation
	Description

	Financial Aid > Fund Management > Generate FISAP Reports > FISAP Report 20xx-20xx
	Running the FISAP report



Note:  The year range on the navigation menu represents the aid year the FISAP Report is requesting funds for. Ensure that once you are on the “Report on Eligible Aid Applicants for Award Year…” page, that the Aid Year you are reporting FROM is reflected on the top of the page.  
For example, when requesting for funding for the 2025-2026 Aid Year, the FISAP page should list “Report on Eligible Aid Applicants for Award Year 2023-2024”.

Enter a New or Existing Run Control ID

Note: So that Run Control IDs in the system are all unique, make sure to put your college code and initials in the Run Control ID i.e. WA060_PROCESS_FISAP_ DE

Select the Institution from the drop down menu

Select the Aid Year you are reporting on from the drop down menu.

See note below for using Overrides and Print Student List fields

If using Print Student List functionality enter the appropriate aid year file path /CSTRANSFER/WAxxx/ExternalAwards20yy/
Where xxx represents the college code (ex: WA300), yy represents the aid year associated with the folder in the file path where you uploaded the file to
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See explanation of Overrides below
[image: ]

“Are eligible citizens based on the Social Security Administration (SSA) Citizenship Indicator database match, DHS/INS database match, and secondary DHS/INS database match. You can view the student's citizenship status in the SSA Citizenship Indicator field on the Database Matches page. Additional logic allows either the DHS/INS Match Override or SSA Citizenship Indicator Override on the Database Matches page to determine eligible citizenship status. To do this, select either the SSA Citizenship Override check box or the DHS/INS Match Override check box or both on the Eligible Aid Applicants for Award Year 20nn-20nn page.”

By selecting the SSA Citizenship and DHS/INS Match override check boxes you ensure the students you overrode the database match on during the aid year will be selected.  
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Print Student List- Select this check box to get an itemized list of students reported in the Eligible Applicant and Program Summary grids.  See outcomes below.

When ready, select Run

From the Process Scheduler Request select OK
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Ensure that the FAPFSP26 process runs to “Success” and “Posted”
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Select the Details link

From the Process Detail page select View Log/Trace
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From the View Log/Trac select the fapfspxx_xxxxxxx.PDF link

[image: A screenshot of a data report
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The FISAP report will open

Review for discrepancies and update source information as needed

This report can be run multiple times until desired outcome is achieved to report outcomes to the Department of Education

[image: A close-up of a document
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Select the fapfspxx_xxxxxxxx.out link
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Description automatically generated]

This will display a list of EMPLIDs, and various ISIR and FA Term information used in FISAP selection.

Messages that will need your review includes the following:

No Active STDNT_FA_TERM found for EMPLID=xxxxxxxxx

[image: A screenshot of a computer
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The message is indicating the student has FA Terms built but all of them are inactive so the student will not be picked up on the FISAP. 

Review the student’s awards and enrollment to determine if you need the student to be picked up on the FISAP. 
If the student should be picked up on the FISAP, update the FA term that should be active to Active. 

If the student is okay not being picked up on the FISAP, no action is needed.
 
No NSLDS_LOAN_YEAR on STDNT_FA_TERM for EMPLID=xxxxxxxxx
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The message is indicating the student has no NSLDS Loan Year on an active FA Term so the student will not be picked up on the FISAP. 

Review the student’s awards to determine if you need the student to be picked up on the FISAP. 
If the student should be picked up on the FISAP, update the NSLDS Loan Year field on the FA terms that are active

If the student is okay not being picked up on the FISAP, no action is needed.
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Info about FISAP from Oracle
The FISAP report includes only students who:
· Have an FA Term (financial aid term) build source of T-Term or M-Manual. 
· Have an official Institutional Student Information Record (ISIR) on file.
· Are eligible citizens based on the Social Security Administration (SSA) Citizenship Indicator database match, DHS/INS database match, and secondary DHS/INS database match. 
· Have awards with financial aid item types of FSEOG, Federal Perkins Loan, Federal Work-Study, or Federal Pell Grant at the time of disbursement. 

At the end of the student list will be the .CSV files that contain the itemized list of students reported in the Eligible Applicant and Program Summary grids. 
*Please Note*
The list of .CSV files will be available when using the Print Student List functionality while running FISAP

· ELIGAPPL- Eligible Applicants
· DISTFWSP- FWSP Recipients
· DISTPERK- Perkins Recipients
· DISTSEOG- SEOG Recipients
· DISTUNDP- Unduplicated Count
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Copy the .CSV file name and use the Upload/Download page to open the information.

NOTE:  File path names are case sensitive and the .csv needs to be included in the Run Control parameters where appropriate for the process to pick up the file.

This copy/paste can be done for each of the categories indicated above. 

Use the same File Path used while running the FISAP process.
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[bookmark: _Toc174600764]Reporting for Section D and E of FISAP

	Navigation
	Description

	Reporting Tools > Query > Schedule Queries
	The following queries have been developed to fulfill the need of reporting Unduplicated and Tuition and Fees for FISAP.  



QCS_SR_FISAP_UNDUPL_HEADCOUNT 
This query presents an unduplicated headcount of students enrolled during any given Aid Year by Institution.

Due to size of the query the recommendation is to run it using Schedule Queries

Enter a New or Existing Run Control ID

Note: So that Run Control IDs in the system are all unique, make sure to put your college code and initials in the Run Control ID i.e. WA060_FISAP_UNDUP_HEADCOUNT_DE

Enter the query name and select Search

When the Scheduled Query Search Page opens select the Query link

Enter Edit Prompts

Select OK
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Select Run
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Ensure the process runs to Success and Posted. 
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From the Schedule Queries page select Report Manager. 

Note: Report Manager can also be accessed through the Process Monitor as shown above
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Note: Schedule Query results can also be accessed through View Log Trace in the Details link of Process Monitor

Select the Administration tab then Undupl Headcount by Aid Year
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When the report page opens select the QCS_SR_FISAP_UNDUPL_HEADCOUNT-xxxxxxx.CSV (Where xxxxxxx is Process Instance number)

A download request will be opened depending on browser – Select OK

[image: A screenshot of a computer

Description automatically generated]

Allow the .csv file to open

This step will display the count

[image: A screenshot of a calculator

Description automatically generated]








	Navigation
	Description

	Reporting Tools > Query > Schedule Queries
	The following queries have been developed to fulfill the need of reporting Unduplicated and Tuition and Fees for FISAP.  



QCS_SF_FISAP_TUITAMT
This query is designed to present tuition and fees for the students identified in the unduplicated head count query.  The following is included in the tuition amount calculations:
· Tuition Fees
· Mandatory Fees
· Self-Support (Credit) 
· Course Fees
· Waivers

Due to size of the query the recommendation is to run it using Schedule Queries

Enter a New or Existing Run Control ID

Note: So that Run Control IDs in the system are all unique, make sure to put your college code and initials in the Run Control ID i.e. WA060_FISAP_TUITAMT_DE

Enter the query name and select Search

When the Scheduled Query Search Page opens select the Query link

Enter Edit Prompts

Select OK
[image: A screenshot of a computer
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Select Run
[image: A screenshot of a computer

Description automatically generated]

[image: A screenshot of a computer

Description automatically generated]

[image: A screenshot of a computer screen

Description automatically generated]

Ensure the process runs to Success and Posted

[image: A screenshot of a computer
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From the Schedule Queries page select the Report Manager. 

[image: A purple arrow pointing to search box

Description automatically generated]

Note: Schedule Query results can also be accessed through View Log Trace in the Details link of Process Monitor

Select the Administration tab then FISAP Tuition Amount

[image: A screenshot of a computer screen

Description automatically generated]

When the report page opens select the QCS_SF_FISAP_TUITAMT-xxxxxxx.CSV (Where xxxxxxx is Process Instance number)

A download request will be opened depending on browser – Select OK

[image: A screenshot of a computer
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Allow the .csv file to open

This step will display the amount

[image: A screenshot of a calculator

Description automatically generated]

End of Process.
[bookmark: _Toc174600765]Troubleshooting

Users have various methods available to assist with reconciliation troubleshooting.  
By running various queries and reports such as the Fund Roster a user can pinpoint where discrepancies have occurred.
Please see Fund Management Business Processing Guide for running queries and Fund Roster.



The example below shows a discrepancy that was found by running the Fund Roster and filtering the columns to discover students that did not have funds authorized and disbursed.  It can also show were cancellations have occurred but the funds and not been un-authorized and un-disbursed.

The discrepancy was found by taking your SEOG Total Query xlsx file and summing the Offered, Accepted, Authorized, and Disbursed columns.  

[image: ]

[bookmark: _heading=h.4f1mdlm]Filter by those zero amounts and amounts that are different that are in the Authorized/Disbursed columns.  It was discovered that two students’ incorrect aid were displayed.  Their awards would need to be adjusted on the award page and the authorization and disbursement process would need to occur to clear these errors.
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